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Introduction  
 
SMART eResources (SMART eR) is a web application that allows employees access to their 
own information.  It is up to the District to decide what to implement to meet their needs. 

Logging into SMART eR 
 

 
 

 
For new employees and employees who have never logged into SMARTeR the User ID 
is your employee ID number.  The Password is the District number plus the last 4 digits of 
your social security number (no spaces). 
 
District:  Verify the district number displayed in this field is your school district.  If not, 
change the dn=xxxx in the URL to select your district number. After initial login you will 
be forced to change your password.  
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After “Save” is chosen you will receive the following message. 

 
 
 Once “OK” has been selected you will return to the login window and required to log in 
using your new password. 
  
Once logged in employees are required to choose either email or text message format for 
Dual Authentication verification. 

 

Once they click on their choice, a verification box will display and an email or text will be 
sent similar to this: 

“Your SMART eR verification code is 267828. You must enter your code in SMART eR to allow eR access. 
Your code will expire in 30 minutes. If you did not make this change, please contact the Business Office.” 

 

 

 

The code can be entered in SMART eR and then Verify can be clicked. If it is entered 
correctly, you will then be logged into SMART eR. If not, the process will start over. After 
three unsuccessful attempts, the account will be locked. 
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Changing Password  
Password can be maintained or changed using icons provided in the upper right corner of 
the Home page.   

  Select Settings to change password and security questions in SMART eR. 

  Select Logout to exit SMART eR.  Users should always log out of SMART 
eR to keep their data safe especially if they are using a public computer 

  Select Help with this Page when you are on a webpage to view SMART 
eR documentation. 

 
 

Announcements and District Forms 

Announcements, Notifications, District Forms and/or Employee Forms appear on the 
Home page.  This module provides a way for Administration to send electronic 
announcements and notices to employees which are visible once the employee has logged 
into SMART eR. 

Once you are logged in, the Announcements page will be displayed. 

Below is an example of what is displayed.  Any “Announcements” sent to the employee 
will be referenced on this page.  

Click on the “View” button and the message will display in the message box section. 

To delete, check the box in the row(s) you want to delete, then click on “Delete Selected” button. 
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To access any forms that have been attached, click on the “District Forms” button. Click 
on the “View” tab to view and/or print the forms. 

 

SMART eR Menu Items Defined 

Navigating SMART eR 
Key Menu Items: 

A. My Frequent Places (left sidebar).  This feature tracks the pages visited most 
frequently by the employee.  It will list the top five most accessed places.  The same 
pages and reports are also available in the normal menu view.  The user will not see 
anything here until they access a page. 

 

B. Menus (left sidebar).  The Menus can be opened or closed by clicking on the plus   

or minus  next to the menu name.  SMART eR automatically opens the Payroll 
Items menu. 

C. Home.  The Home menu provides a snapshot of items that are relevant to all employees.  
There are display buttons that allow the user to quickly View Pay Stub(s), TimeOff, 
or YTD Pay (year-to-date information).  The pages display the most current values 
available real-time.  Detail can be viewed by clicking on the View Detail buttons.   
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D. Browsers (bottom of page).  To view browsers supported for the current release of 
SMART eR click on Visit our About page link.   

 
 

Pay and Personal Information 
My Information | Payroll Items provides payroll information about an employee detailing 
contract or notice of assignment information, benefits summary, pay stub detail, year-to-
date pay information, TimeOff detail if the employer utilizes this feature, and pay 
information detailing information about an employee’s pay for the fiscal year (e.g. lane, 
step, FTE, days and hours).  The Payroll Items menu also provides an electronic option 
for the form W-2 and ACA Form 1095.  If the employer allows, the employee can also 
update direct deposit information and Form W-4 used for tax withholding. 

TimeOff 
TimeOff is displayed on the Home page if the district uses the TimeOff Module.  
The page displays the most current values available.   

 

Detail can be viewed by clicking on the link to View TimeOff Detail.   

 This allows you to view the TimeOff plans, balances and usage. 
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TimeOff Information. 

 Please Select a Date Range.  Use the drop down box to select a different year to view 
 Click  the plus    to view detail 

 Click the minus  to hide detail 
 To print click Print Timeoff Detail button  

 

Pay Stub 
Pay Stub is displayed on the Home page.  The page displays the most current values 
available.  Detail can be viewed by clicking on View Pay Stub.  Year-to-date pay 
information can be viewed by clicking on View YTD Pay. 

 This allows you to view pay detail from gross to net on your most recent paycheck.  

 

The Pay Stub page provides links to Preview Entire Pay Stub, view Other Pay Stubs, Print 
Entire Pay Stub, View TimeOff Detail, use the Federal Withholding Calculator or the MN 
Withholding Calculator. The employee is required to consent to view this information. 

This screen shows the 
different TimeOff Plans 
that are available to the 
employee. 
 
Time off information 
from prior years can 
also be viewed by 
selecting the 
appropriate date range. 
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Preview Entire Pay Stub.  Click to view the entire pay stub. 

 Pay Stub Header.  The header displays the employer name, address and employer 
phone number.  It shows the employee name, address, original hire date and adjusted 
hired date.  This information is supplied to allow the employee to print the pay stub for 
employment verification. 

 Payment Type.  This provides the pay date for direct deposit of payroll or a printed 
check.  If the employee uses direct deposit banking information is displayed. 

 Method of Pay.  Defines the type of pay earned by the employee. 
 Deductions (* = Pre Tax).  This area displays employee deductions.  If the deduction 

is followed by an asterisk it is a pre-tax deduction meaning it is sheltered from federal 
tax, state tax and FICA for flex deductions. 

 Benefits.  This area displays employer contributions that are part of the employment 
agreement with the district. 

 Taxes.  Displays the tax withholding. 
 Pay summary.  Displays the current taxable income and calendar year to date (YTD) 

for gross pay, federal tax, state tax, Medicare and OASDI, deductions and net pay. 
 Timeoff.  Displays summary information for TimeOff. 
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$ Other Pay Stubs.  Allows the employee to select a year to view, and then select a 
specific date.   

 This displays a list of pay stubs descending by date.  Click on the Date/Amount 
summary button to see the data of a previous pay stub. 

 
 
Year to Date Pay.  The Year to Date Pay displays year to date information for the 
current calendar year as of the date viewed.   
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 An employee can use the dropdown arrow to view prior year earnings.  This page 
provides links to Preview Entire YTD Pay, Print Entire YTD Pay, provides a Federal 
withholding Calculator and a MN Withholding Calculator. 

 
 

 
Payroll Items 
Additional Payroll Items found under the Home menu | My Information are listed below.    

1. Payroll Items 
a) Fiscal Benefits Summary 
b) Contract Information 
c) Direct Deposit 
d) Pay Information 
e) ACA Form 1095 
f) Wage Statement 
g) W-4 
h) W-2 
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Contract Information 

The Contract Information page can be viewed if the district enables this feature.  Employees 
can view and sign contracts or notices of assignment for the contract year selected. 
 

 
 

Direct Deposit         

The Direct Deposit page allows an employee to view their current direct deposit for 
distribution of pay.  If allowed by the employer, the employee can change the direct deposit 
amounts allocated to their bank account(s) online.  An electronic signature is required to 
verify employee identity.  Districts determine how many accounts each employee can 
enter.  The change will not be active until it is signed by the employee and then moved into 
payroll, which could take a few payroll cycles depending on the date the change is 
processed in payroll. 
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Change Direct Deposit.  If allowed by the employer click on the Change Direct Deposit 
tab to update your direct deposit account(s).  If you currently have more than one direct 
deposit account active, you must re-enter the information for each account. 

An Electronic Signature is required.  The employee is asked to authorize the change and 
verify their identity.   

 
 
The employee can view an example of where to locate the routing number and account 
number by clicking on the View Check Example button. 

 
 

Pay Information 

The Pay Information page detail information about an employee’s pay for the fiscal year.   
The page displays pay description, lane, step, FTE, pay amount, hours per day and days 
per year if district activates this option for employees.  Employees can view information 
from prior years using the drop down box to select a different year. 
 

Sign.   
To save changes and sign, read the 
Electronic Signature consent message, 
click in the checkbox 

, then 

click on the  button.  You will be 
asked to verify your identity.  Enter your 
current password and last four digits of 

your SSN, then click on the   
button. 
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ACA Form 1095 

The ACA Form 1095 page allows employees who consent, the ability to view and print 
their ACA Form1095, if a form is used to them.  A consent message will display the first 
time a user clicks on the page.  If the employee consents, the IRS allows the employer to 
furnish the form to the employee electronically.  Generally, this means the employee will 
receive their form sooner than paper form, and be more convenient for them as well.  If at 
any point an employee wishes to withdraw their electronic consent, they may do so in a 
written request to their employer. 

After consenting, employees will need to verify who they are when they access a page 
where their SSN is displayed for security reasons. 

 

Employees can view prior years by using the drop down box to select a different year. 

 
Caution: If you are using a public computer the form is allowed to be viewed but will not 
automatically save as a .PDF document. The user can select to print or save as a .PDF file; 
however, the .PDF option is not recommended on a public computer for a tax form. If the 
document is saved as .PDF file, copy the file to a flash drive OR delete the .PDF form before 
signing off the public computer! 
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Wage Statement 

The Wage Statement page is used to make sure employees receive their proper wages 
from their employer in response to the MN Wage Theft Law that went into effect on July 
1, 2019.    Employees can print and electronically sign their individual Wage Statement 
online.  Employees can view information from prior years using the drop down box to 
select a different year. 
 

 
 

W‐4 and W‐2 

Employees can view online what is currently being claimed for tax withholding based on 
their completed Form W-4.  The Form W-2 and W-2 Information sheet can also be viewed.  
If the employee has not consented to receiving the W-2 electronically the option to view 
or print their W-2 is not available. Once the user has consented to an electronic W-2 both 
the current and prior years can be viewed. 

W-4 

Prior to viewing W-4 tax withholding information employees will need to verify who they 
are when they access a page where their SSN is displayed for security reasons. 

 

 

Change W-4 Withholding.  If allowed by the employer, click on the Change Withholding 
tab to update your federal and state withholding allowance(s) online.   
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An Electronic Signature is required.  The employee is asked to authorize the change and 
verify their identity.  Changes will not be active until it is signed by the employee and then 
moved into a payroll date waiting to calculate.     

 

The employee can access both the Federal and State Withholding Calculator for online 
assistance in determining changes. 

 

The employee can view an example of the Federal or State W-4 by clicking on the View 
Blank W-4 button, as applicable. 

 

W-2 
 

Sign.   
To save changes and sign, read the 
Electronic Signature consent 
message, click in the checkbox 

, then click on the  button.  
You will be asked to verify your 
identity.  Enter your current 
password and last four digits of your 

SSN, then click on the   
button. 
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The W-2 page allows employees who consent, the ability to view and print their ACA 
Form1095, if a form is used to them.  A consent message will display the first time a user 
clicks on the page.  If the employee consents, the IRS allows the employer to furnish the 
form to the employee electronically.  Generally, this means the employee will receive their 
form sooner than paper form, and be more convenient for them as well.   

After consenting, employees will need to verify who they are 
when they access a page where their SSN is displayed for 
security reasons. 

 

The form selected will now be available for preview when clicking on the “Go” button.   
Employees can view prior years by using the drop down box to select a different year. 

 
 
From the Generate W2 Form page, click on the Preview W2 or Print W2 button.   

 
 

W-2 Information Sheet 

W-2 Information Sheet is available to all employees, even if the employee has not 
consented to an electronic W-2. 
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About Me 
The About Me group can be accessed under the Home menu | My Information.  This 
section contains the employee’s personal information and credentials, including emergency 
contacts, medical information and licensure. Districts have the option of allowing the 
employees to make changes to this information. 

2. About Me 
a) Dependents 
b) Education 
c) Emergency Contacts 
d) Employee Information 
e) Licensure 
f) Medical Information 
g) Training, Tests & Skills 

 
 
 

Dependents 

The Dependents page allows employees to view and update dependent information if the 
employer allows access.  To add a dependent click on Add New button. 
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Education 

The Education page allows employees to view the information the district has on file for 
their education along with continuing education credits (e.g. Lane Changes).  

 

Emergency Contacts 
The Emergency Contacts page allows employees to view and update information if the 
employer allows access.  An employee can add a new contact, edit information for an existing 
contact or delete a contact if no longer valid. 

 
 

Employee Information | Address 

The Employee Information page displays information from SMART HR.  An employee 
can view and update employee information if the employer allows access.  Editable tabs 
include Address, Contact information and Other personal data. 

Address changes may not become effective immediately depending on payroll processing.  
When making an address change also update your address for other benefits or notify the 
district office for assistance. 
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Employee Information | Contact 

 

Employee Information | Other 

 

Medical Information 

The Medical Information page allows employees to view and update medical information if the 
employer allows access. 

 

Licensure | Teaching Licenses 

The Licensure page allows employees to view their teaching license, other licenses and 
certification information, including expiration dates.  A link to the MDE website is 
provided so the employee can view their record on file with the State of Minnesota. 
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Licensure | Other Licenses/Certifications 

This section tracks other licenses and certifications such as Asbestos Certification, Boiler 
License, CPR certificate, Driver’s License, Occupational Therapist, and Registered Nurse. 

 

Training, Tests & Skills 

Additional Training, Tests & Skills can be viewed in this window.   It is used to track 
other types of training for staff and the date the training was completed. 

 
 

 
Requests 

Requests includes Online Shopping, Order Requisition Entry, Reimbursement Entry, 
Leave of Absence Request and Vehicle Request.  This group can be limited to specific 
employees through secured access.  Region V will set up user access based on the request 
made by the district administration.  

 

Online Shopping 
The first method for web-based ordering is Online Shopping for specific outside vendors 
via a “punch-out” system.    The authorized employee chooses from a predetermined list 
of approved vendors.  They are able to go to the vendor’s website and place items in their 
“shopping cart”.  They transfer their cart of goods into a requisition or purchase order.  
Once the purchase order is approved, the order can be electronically transferred back to the 
vendor via SMART eR. 
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Order Requisition Entry 
The second method is the Order Requisition Entry which allows authorized district 
personnel to create an order request in SMART eR to be transferred into SMART Finance 
for requisition or purchase order processing.  They do not go to a vendor’s website for this 
process.  They simply choose an active vendor from the list and key in the items they are 
requesting.  The request is transferred into SMART Finance where it becomes a requisition 
or purchase order.   

 

Reimbursement Entry 
Reimbursement Entry is a web-based system for users to enter employee reimbursements 
and route for approval to be paid through payroll.  This process is designed to save time. If 
allowed by the employer, the staff member will enter the request for reimbursement instead 
of Payroll personnel. 
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Responsibilities 

The Responsibilities group includes Approvals, Place Order, Property Assignment, Vehicles 
and Supervisor’s Report of Accident.  Like the Requests group, it can be limited to specific 
employees through secured access.  Region V will set up user access based on the request made 
by the district administration.  

 

Place Order 

Place Order is used to electronically submit approved purchase orders created through the 
Online Order “punch-out” feature in SMART eR.  Only approved orders will appear for 
selection.  To see the details of the order, click the + symbol. 

 

Supervisor’s Report of Accident 

Supervisor’s Report of Accident (SRA) is used to notify the district office of an injury. 
Supervisors can be given access to this page to complete the SRA form online. A confirmation 
email is sent to a designated person to let them know that an SRA has been completed. The 
information from the SRA will auto-populate the First Report of Injury (FROI) report in SMART 
HR. The SRA is often used by the Worker’s Comp Company to investigate a claim. 

 


